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The Measuring and Observation Tool in Sports (MOTS) has been designed to facilitate the systematic observation of sports. It is a user-friendly tool developed to help researchers observe, codify, register, and analyze any
situation that occurs in a natural or habitual context in which behaviors are spontaneous. Users can define up to
12 mutually exclusive code sets and up to 120 different behaviors to facilitate data collection and can work with
any observational data type: event sequences, event sequences over time, state sequences, interval sequences,
or multievent sequences. MOTS plays digital video files, which allows for video and taxonomic tools to be
displayed on the screen at the same time. The observations are registered automatically, including the time and
duration of the event, in frames and seconds simultaneously. Furthermore, the data analysis feature allows the
user to calculate the percentage of intervals, the frequency distributions, and the conditional probabilities.

The various techniques used for observation have
clearly undergone a notable development. The original
paper-and-pencil observations were first superseded by
the use of tape recorders, and nowadays a wide range of
sophisticated computer technology is available (Franks,
Wilson, & Goodman, 1987); for example, digitizing tables
or voice recognition programs have made the tasks of researchers and observers much less arduous. Nevertheless,
the large volume of data that may be recorded within the
framework of observational methodology (Perea, 2008)
has meant that the keenest of researchers have had to develop specific technologies for this purpose.
Numerous software applications have been designed
using current technology in order to record perceivable
behavior. In this regard, Darst, Zakrajsek, and Mancini
(1989) listed several programs that were already being
used up to 40 years ago for the observation of verbal and
nonverbal behavior: FIAS (Flanders’s Interaction Analysis System, from 1965), RANKIN (the Rankin Interaction Analysis System), BAT (Behavioral Analysis Tool),
CAFIAS (Cheffers’s adaptation of FIAS), CSFI (the
CAFIAS Supervisory Feedback Instrument), DAC (the
dyadic adaptation of CAFIAS), and CBRS (Coaching Behavior Recording System). Kahng and Iwata (1998) also
described a series of computer applications, such as BOS
(Behavior Observer System), which uses PDAs (the Apple
Newton or USRobotics Pilot) to codify behavior with different onscreen buttons. Users can access the tools already

created for a number of observational contexts, and they
may also edit the tools or create new ones, choosing from
a list of behaviors given by the system or writing directly
over the buttons. These tools allow for up to 24 different
responses to be codified during a session. Another system
mentioned by Kahng and Iwata is PCS (Portable Computer Systems), which comprises recording programs and
data analysis. The data recording program enables users
to record frequency, duration, latency, and time between
responses for up to 45 different events, and it can also capture data with discontinuous selection tests. Finally, the
authors also mentioned SCOPE (Social Interaction Continuous Observation Program for Experimental Studies),
which is capable of recording up to 21 different responses
during an observation session, as well as recording the
frequency and duration of responses.
Other programs currently available include ANSEC
(Quera & Estany, 1984), CASE (Computer Assisted
Sports Evaluation; Franks & Goodman, 1984), CABER
(Capture and Analysis of Behavioral Events in Real
Time; Patrick, 1985), SATS (Yoder & Tapp, 1990), The
Observer (Noldus, 1991), C-QUAL (Duncan & Sayre,
1991), ODAP (Observational Data Acquisition Program;
Hetrick, Isenhart, Taylor, & Sandman, 1991), VideoNoter
(Roschelle & Goldman, 1991), SHAPA (James & San
derson, 1991), CAMERA (van der Vlugt, Kruk, van Erp,
& Geuze, 1992), EVENT-PC (Ha, 1992), TRANSCRIPTOR (Hernández Mendo, Ramos, Peralbo, & Risso,
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1993), PROCODER (Tapp & Walden, 1993), MOOSES
(Multi-Option Observation System for Experimental
Studies; Tapp, 1994), MacSHAPA (Sanderson et al.,
1994), DATACAP (Emerson, 1995), DODS (Direct Observation Data System; Johnson et al., 1995), ProBES
(Professional Behavior Evaluation System; Ricketts,
1995), VBA (Virtual Behavior Analyst; Winston, 1995),
Theme (Magnusson, 1996), Theme Coder (PatternVision,
2001), VTLOGANL (Hecht & Roberts, 1996), SDIS–
GSEQ (Bakeman & Quera, 1996), BEST (Sharpe & Koperwas, 1999), DCA (Data Collection Assistant; Bluestem
Technologies, 1997), ObsWin (“Observational data collection analysis for Windows”; Martin, Oliver, & Hall,
1999), CODEX (Hernández Mendo, Bermúdez Rivera,
Anguera, & Losada, 2000), EBASS (Ecobehavioral Assessment System Software; Greenwood, Carta, & Dawson, 2000), The Observer Video-Pro (Noldus, Trienes,
Hendriksen, Jansen, & Jansen, 2000), and CURIOUS
(Gorospe, Anguera, Hernández Mendo, & Saracho, 2001).
Furthermore, two software tools are designed specifically
for application to sports to enable perceivable behavior to
be recorded: SOF-CODER (Jonsson, 2004) and SOCCAF
(version 2.2) video (Perea, Alday, & Castellano, 2006). In
the latter software, the definition of variables is set by the
program, but in both systems the recording of data follows
the chronology of events. This variety notwithstanding, the
tools available still leave certain areas unaddressed.
Reviewing these observational programs has, however,
enabled us to identify a number of functionalities that
were considered when developing the MOTS software
application. For example, despite small differences between the applications we analyzed, a number of generalizations can be made about them. (1) The observations,
recording, and analyses have their own modules, such
that the access permitted by the programs to the video,
the category system (which tends to be preset), and the
data register is often not simultaneous. (2) The option
for setting up and defining the codes of the observation
tool may be closed or open; that is, the codes may be
already defined by the application itself, or the user may
be allowed to define them. (3) Depending on the application, the taxonomic system may be visible or hidden on
the computer screen; in other words, in some programs it
is necessary to open a drop-down menu to select the category, whereas in others the behaviors are visible onscreen.
(4) In some programs, codes may be introduced using
the mouse, whereas others only allow this operation via
the keyboard; in some cases, it is also necessary to write
the code each time a category occurs. (5) The software
applications do not generally enable the simultaneous use
of digital video while they are running. (6) The types of
data that can be coded are not the same for all of the programs: Some are based on events and others on states or
sequences (event sequences, state sequences, interval sequences, and multievent sequences), whereas some allow
all types. (7) Time is not recorded by all of the applications.
(8) In the analysis section, the descriptive statistics most
commonly provided are absolute and relative frequencies,
durations, some transitions, and some kind of concordance
index, although not all of the programs include all of these.

Finally, (9) not all of the programs allow data to be exported to other applications.
Characteristics of MOTS
It is a fact that the different software tools we analyzed
do not cover the needs of researchers. Indeed, the complexity of motor situations and the nature of competitive
activity do not favor the use of “closed” software tools, in
which the researcher needs to adapt the observational tool
to the possibilities the application will encounter. MOTS
was developed in order to satisfy all of the requirements
that an application of this kind should fulfill:
User-friendliness. The video, observational tool, and
registered data appear simultaneously on the screen. They
are directly accessible, and no advanced computer skills
are needed to use the application.
Possibility of customizing (ad hoc) the observational tool.
Once it has been set up, the observational tool can be used
immediately; up to 12 criteria and 120 categories can be defined. The names and number of the criteria, and the categories under each criterion, are directly defined by the user.
Automatic recording of the time at which an action
takes place. When registering an event, the time and duration of the event are automatically saved, in frames and/or
seconds, depending on the required accuracy.
The registered data are sequentially recorded, and thus,
in addition to the typical analysis of frequencies, it is possible to conduct intensive diachronic studies—that is, to
use any type of data: event sequences, event sequences
over time, state sequences, and multievent sequences.
Direct linkage between video and events. The registered
data are linked to the video frame in which the events were
observed. The user can always access any part of the observed session, making it easy to search the behaviors that
were observed and registered during the session.
Less time required for observation. Video and data registering are controlled through simple mouse clicks.
Higher data quality. The facts that the categories are
defined and the registered data do not need to be transcribed help to avoid errors.
Simultaneous data analysis. The analysis tool automatically performs frequency and duration analyses (in frames
and/or seconds). The user can also regroup the registered
data according to classification levels—that is, by relating
certain variables or features to one another (in the form of
contingency tables, with two or more inputs).
The data files may be exported to the more commonly used statistical packages, such as SPSS for Windows, SDIS–GSEQ (Bakeman & Quera, 1996), GT (version 2.0.E, for generalizability study; Ysewijn, 1996), and
SAS (SAS Institute, 1999; Schlotzhauer & Littell, 1997).
Functional Structure of the MOTS Program
Once the software has been installed, a new MOTS
folder will appear under Programs on the Start menu. This
folder contains the executable file and the user guide.
When starting MOTS, the main window will appear.
From here, the user can access the three principal
modules—Tool Design, Observation, and Analysis—by
clicking with the mouse on the corresponding button.
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If there are any unsaved changes, MOTS will always ask
the user to save them before closing. The program is only definitively closed when the Close (3) button at the upper right
of the main window is clicked. At this point, any information
that was not saved will be definitively lost. In the following
sections, we describe the different modules of MOTS.
Setting criteria. Clicking on the Tool Design button in
the main window causes a new window to be opened (see
Figure 1), from which users can design their own observational tools, save them, or modify them.
When the module is opened, MOTS is ready to design
a new observational tool. Observational tools include the
following elements (see Figure 2): (1) Criterion ID, the
unique identification number for each criterion; (2) Criterion Name, given to the observation criterion; (3) Category Name, unique for each category, which may have
up to five characters; and (4) Description, which defines
the meaning of the category (the use of this element is
optional, although recommended).

Figure 1. Criteria for the observational tool are set using the
Tool Design window.

Figure 2. Saving the observational tool.

A new criterion is added by writing its name in the text
box and clicking on Add Criterion. The name of the criterion will appear automatically in the Criteria frame. At
this point, the categories for this criterion can be defined
by writing a name and description (optional) and clicking
on the Add Category button for each new category. A new
row will be added to the table for each category.
Users may modify the categories by double clicking on
the category to be modified. The values for this category
will appear in the Category frame, in which the required
modifications can be made. The modified category will
be updated in the table by clicking on the Modify button.
A category can be deleted by double clicking on its row
in the table and then clicking the Delete button. A criterion
can be deleted by deleting all of the categories contained
by this criterion.
Once the observational tool has been designed, users
can save it as a Microsoft Excel document for subsequent
use by clicking on the Save or Save as . . . submenus in
the File menu.
The observational tools are saved as Microsoft Excel
files (see Figure 3) and may have up to 120 categories
distributed across 12 criteria. Each criterion must contain
at least one category, and no two criteria or two categories
may have the same name.
Users may retrieve previously saved observational tools
in order to visualize, modify, or save them again, either in
the same or in a different location. A previously created
observational tool can be opened by clicking Open in the
File menu.
Observation. After clicking on the Observation button, a new window will appear. From here, users may open
an observation tool, observe a sports event, and register
their observations. The registered data may also be gathered, saved, retrieved, and modified.
The first step for registering the data is to select the
observational tool that was previously created using the
Tool Design functionality. The observational tool can be
selected by clicking the Examine button. Once the observational tool has been selected, a new frame per each category and a new button per criterion will automatically
appear on the screen (see Figure 4).
The Observation module allows users to reproduce
AVI, MPEG, and MPG video files. The file to be reproduced can be selected by clicking on the Load Match submenu from the Match menu, located on the menu bar (see
Figure 5).
Once the session to be observed has been selected, the
user can play the video file by clicking the Play button. Of
course, the typical buttons Previous (move the video to the
previous track), Next (move the video to the next track),
Pause, Rewind (move the image back 5 sec), Forward
(move the image forward 5 sec), and Stop (the right mouse
button can also be used to stop and restart the image) can
also be used. There is also a slide bar for forwarding or
rewinding the video in 1-min intervals.
Observation can begin once the observational tool has
been selected and the video is running. If the user observes one of the events defined by the observational tool
and wants to register it, he or she just needs to right click
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Figure 3. Microsoft Excel document containing the observational tool.

Figure 4. The Observation window.

Figure 5. A sports match loaded for registering data.
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Figure 6. The Data window.

Figure 7. Microsoft Excel document containing the registered data.

Figure 8. The Analysis window.
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Figure 9. Microsoft Excel document containing the frequency analysis of the data.

Figure 10. Microsoft Excel document containing the contingency table of the data.
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with the mouse to freeze the image and click on the category buttons that correspond to the observed events. If the
Enter Data button is clicked, the data will be definitively
registered, and the image will start running again so the
registering session can continue. Should more than one
category be selected within the same criterion, a pop-up
error message will appear.
The registered data and the time at which the action occurred will appear in the Data window (see Figure 6). By
double clicking on one of the rows of the table, the user
can move in the video file to the instant at which the event
was observed.
The program stores the registered data in an Excel file.
These files can be saved by clicking on Save or Save as . . . in
the File menu. The program enables users to delete erroneous
observations by clicking on Delete Data in the Data menu.
This operation will delete from the table the last observation
(row) added by the user.
Since the data registering cannot always be done in
a single session, and more than one session may be required to complete the observation, MOTS enables users
to retrieve the data files and continue with the observation
and data registering from the point at which they left off.
Files are retrieved simply by clicking on Open in the File
menu and selecting the file with the registered data. The
registered data are stored in Excel files in which each row
corresponds to one register, including the time in frames
at which the event was observed, the duration of the event
(in frames), and the categories of the observed criteria (see
Figure 7).
Data analysis. The Analysis feature will appear when
the researcher clicks the Analysis button of the main window; from here, frequency and duration analyses of the
registered data can be performed simultaneously with the
data registering.
A frequency or duration analysis can be performed by
selecting the data file to be analyzed (the one containing the registered data) and the observational tool used,
along with the observation, and then clicking on the Start
Analysis button. The results will automatically appear on
the screen (see the left side of Figure 8). Users should
bear in mind that the analysis may take several seconds,
or even minutes, depending on the amount of data to be
analyzed.
As a second option, the registered data may be regrouped by levels of classification (n-level contingency
tables)—in other words, certain variables or features may
be related to one another. This is particularly useful when
working with sequences or multievents. Users can relate
as many criteria as are available in the observational tool
and can carry out the operation as many times as they wish
(see the right side of Figure 8).
Once the data analysis is complete, the results can be
saved by clicking the Save Analysis button. The analysis
will be saved in worksheets within the Excel file where the
registered data were stored (see Figures 9 and 10).
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